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Vypnout/ zapnout zobrazeni komentarnu

X36DBS - Databazové systémy, Zima 2006, lichy tyden
Zbynék Lstiburek ( Istiburz1 ) Ctvrtek 7.30

Istibuz1 .cvut.cz
ProhiaSuj, Ze jsem swou semestraini praci wpracoval samostainé. Véechny zdroge, ze iderych jsem cerpal, jsou uvedeny v Easti Odkazy.

Pévecky sbor (ukdazkova semestralka a komentare)
Popis

Pévecky sbor je skupina lidi, ktera se viceméné pravidelné schazi na zkouskach, kde nacvicuje hudebni
skladby, jez pak provadi na koncertech v rliznych mistech. Databazovy systém slouZi k evidenci élenské
zakladny, zapujéenych not a koncertnich $att, informaci o konani a programu zkousek a koncert( a také
podrobnych Gdaji o skladbach v repertoaru — pro zjednoduseni prace pfi tisku koncertnich programi.

KOMENTARE

Tohle je komentar k 1. odstavci popisu semesiraini prace.
Zachovava formatovani.

Zobrazeni komentaru si miZete VYPNOUT
- v menu XML Mind Editoru View -> Hide comments )
- pfi html zobrazeni tiacitkem "Vypnout/zaptnout zobrazeni komentaru® pfimo na html strance.

Komentar mizete pouZivat k viastnim poznamkam k ¢astem préce,
déle jej muze vyuZit vas cvicici k tomu, aby piipajil svoje hodnoceni
k jednotlivym ¢astem préce.

Komentovat Ize samostatné:
Jednotlivé odstavce text( v ¢astech Popis, Datové schéma, Skriply, Zavér, Odkazy
obrazek datového schématu
popis SQL prikazu
formulaci v relaéni algebfe
Jjednotlivé SQL piikazy
tabulku pokryti kategorii SQL piikazd.

Dalsi informace o semestraini praci, strukture, poZadavcich a terminech jsou uvedeny
formou komentait: pfimo v tomto dokumentu.

Zpévaci se déli podle své zpévni polohy (typicky sopran, alt, tenor, bas) do hlasovych skupin, z nichz kazda
ma uréeného svého vedouciho. Skupiny mohou mit napf. samostatné (délené) zkousky vedené pravé
vedoucim hlasu.

STRUKTURA SEMESTRALNI PRACE
Semestralka ma tyto ¢asti:
- hiavicka (udaje o vés a o ¢ase cviceni, prohlaSeni o autorstvi, nazev prace)
- popis - struénd charakteristika vaSeho projektu (nékolik odstavcy, kde popiSete
“realitu”, kterou budete ve va$i semestréice databdzové modelovat
- datové schéma (skléda se z obrazku (nejlépe formét png) a diskuse
obrazek je vytvofen néjakym nastrojem pro konceptudlni datové modelovani
(doporuceny je ER Modelar, ale po dohodé se cvi¢icim muZete pouZit jiny).
Diskuse k datovému schématu zahrmuje
vycet integritnich omezeni, které nebylo moZné zahrnout do obrazku (jsou-li)
diskuse ke kaZdé smycce, ktera se vyskytne ve vasem schématu
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- SQL prikazy a piikazy v relacni algebre - vypracujete:
alespon 25 SQL prikazi nad vasi databazi (tak aby pokryly kategorie v niZze uvedené tabuice)
alespori 10 z nich (jen dotazy) formulujete také v relaéni algebre
- tabulka pokryti poZadovanych kategorii vasimi SQL piikazy
- skripty se zdrojjovymi texty vaseho feseni:
- zdrojovy soubor pro datové schéma
- SQL skripty pro vylvoreni vasi databaze (ER modelar ho pro vés vygeneruje)
- SQL skript pro vioZeni testovacich dat do vasi databaze
- SQL skript s odladénymi piikazy
- log soubor (nasnimany vystup), kterym doloZite, Ze vase SQL piikazy jsou funkéni
a vraci spradvné data
- zévérecnou diskusi
- odkazy na pouZité zdroje

V8echny éasti semestralni prace jsou povinné.

ProtoZe noty jsou velmi drahé (pfedpoklada se neporusovani autorského prava kopirovanim:-), vede shor
pfesnou evidenci o tom, kdo ma u sebe ktery vytisk. Noty mohou mit bud podobu part (vZdy jen s notami
uréitého hlasu), nebo partitury (ta obsahuje viechny hiasy). V pfipadé partl to znamenad, Ze rlizni zpévaci
mohou zpivat stejnou skladbu z jinych not. Dale existuji zpévniky nebo sborniky, které obsahuji v&tsi pocet
skladeb, nékdy od rtznych autort.

TECHNOLOGIE A NASTROJE

Semestralni praci odevzdate ve formé XML dokumentu, kfery nahrajete do vaseho projektového adresare na
serveru service.felk.cvut.cz. Do tohoto adresare umistite také vSechny zdrojové souboru a obréazek datového schémalt

UMISTENI PRACE:
http://service.felk.cvut.cz/courses/X 36DBS/prj/<vase_uzivatelske_jmeno> nebo
hitp://service.felk.cvut.cz/courses/Y36DBS/prj/<vase_uzivatelske_jmeno>
technologie piistupu do této lokace je WebDAV, navody a nastroje naleznete na:

http://service.felk.cvut.cz/pubguide/

STRUKTURA DOKUMENTU:

Odevzdana prace (XML dokument) necht je validni dle specifikace sprojekt. Na adrese:
http.//service.felk.cvul.cz/courses/X 36 DB S/xmi/sprojekl/

najdete specifikace ve formatu DTD, XML Schema, Relax NG (sprojekt.dtd, sprojekt.xsd, sprojekt.png).

\Pro editaci prace tedy Ize pouZit libovolny XML editor.
\Kompletni podpora pro forméatovani semestralky (Sablony a ukdzkové semestralky)
\pro kompletni offline praci je:

http.//service.felk.cvut.cz/courses/X36DBS/xml/sprojekt.zip

TVORBA DOKUMENTU (semestralky)

Pokud pouzijete jiny editor nez XML Mind (viz nize), doporucuji stahnout si Sablonu pro semestralku z DBS,
tu oteviit a vyplnit viastnim textem vasi semestraini prace.

http://service.felk.cvut.cz/courses/X 36DBS/xmi/sprojekt/templates/dbs semestral work template.xmi
Pokud toto neudélate, pak je tfeba, aby vas nové vytvoreny dokument odkazoval na formatovaci Sablonu
pro zobrazeni v html podobé. Za specifikaci kédovani v XML souboru:

<?xml version="1.0" encoding="UTF-8"7>

Je treba umistit tuto instrukci pro provedeni:

<?xmi-stylesheet type="text/xsl" href="http://service.felk.cvut.cz/courses/Y36DBS/xmi/sprojekt_htmi.xsi"?>

EDITOR XML MIND - DOPORUCUJI PRO TVORBU SEMESTRALKY
Home Edition tohoto néstroje je volné ke staZeni pro platformy linux i windows:

\http://www. xmimind.com/xmleditor/download. shim!

AZ si ho stéhnete a nainstalujete a spustite, doinstalujte si podporu dokumentu sprojekt (tvorba semestralky): -
Instalace baliku "sprojekt" (§ablony pro semestralku z DBS) v XML Mind

Options -> Preferences... -> Install add-ons
do okna "Download add-ons from this servers"
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pfidat adresu:
http://service.felk.cvut.cz/courses/X 36DBS/xmi/sprojekt. xxe_addon
Options -> Install Add-ons...
Nactou se informace o balicich, tam najdete balik "DBS Semestralni prace”

Po dokonceni instalace je tfeba XML Mind restartovat.

Po dalsim spusténi se vam pres volbu File -> New... v nabidce existujicich format( objevi nabidka:
DBS Semestral Work Documentation

‘a vy si muzete vybral, zda si oteviete Sablonu kam dopinite viastni text semestrélky

(A Template For Semestral Work With Comments) nebo vzorovou semestralku s komentari
(Sample of Semestral Work), coZ presné tento dokument.

KaZzda skladba miZe mit jednoho skladatele (nemusi, mizZe jit tfeba o lidovou pisef, ani anonymnich skladeb
neni malo) a — zejména v pfipadé lidovych pisni — i autora upravy. Rozumi se, Ze Upravu skladeb provadéji
hudebni skladatelé, takZze kazdy skladatel v databazi nemusi byt nutné autorem néjaké skiadby. Vétsi
skladby se mohou délit na nékolik &asti, jejich nazvy byva zvykem uvadét v koncertnim programu.

TERMINY ODEVZDANI - KONTROLNI/ BODY

Vas cvicici s vami na zacatku semestru domiuvi presné terminy 2 kontrolnich bodd (a pisemky.)
To znamena deadline pro odevzdani ¢asti vasi semestralky.
NedodrzZeni deadline bude potrestano strzenim 5 bodt z poctu, ktery miZete za semestralku ziskat (20).

1. Kontrolni bod
- doporuc¢ovany termin (garantem pfedmétu) 3. - 4. cviceni u poéitacl
- kontroluje se: N
- hlavicka semestrélky
- popis
- datové schéma (vCetné diskuse smycek)

2. kontrolni bod
- doporucovany termin (garantem predmétu) zapoctovy tyden
- kontroluji se zbylé ¢asti dokumentace, tedy:
- SQL prikazy
- tabulka pokryti kategorii SQL pfikazi
- skripty se zdrojovymi texty (véetné LOG souboru s naskenovanymi vysledky SQL piikazii)

Pokud jde o sborové zkousky, bylo uvedeno, Ze nékteré mohou byt délené, tj. nékterych zkousek se nemusi
ucastnit viichni. U kazdé zkousky je ale dan seznam téch, ktefi na ni maji byt, a na zakladé toho se eviduje
dochazka. Pro Ucast na koncertech plati stejny princip. U koncert( se sleduje také (hruba) divacka ucast a
vySe vybraného vstupného — kvlli riznym statistikam.

ZOBRAZENI SEMESTRALKY NA www

Pokud dodrZite vy$e uvedeny postup, pak vam staci do vaseho adreséare
na webis umistit (v zavorce jsou uvedené soubory z tohoto pfikiadu):
| xml soubor se semestralkou (test.xml)

obrazek datového schématu (pevecky_sbor.png)

SQL skripty (create.sql, data.sql, query.sgl, output.log)

Jak to bude vypadat ve vysiedku se miZete podivat zde (coZe je :
hitp://service.felk.cvut.cz/courses/X 36DBS/xmifestitest xmi

Motivace pro pouZiti této technologie:

1. zamezeni riiznym nedorozuménim v tom, co ma obsahovat vaSe semestralka

2. véiim tomu, Ze aZ zvladnete préci s néjakym XML editorem, bude to pro vas vyrazné
zjednodu$eni (nemusite se vibec zabyvat grafickou strankou semestralky) ,

13. vyrobenim semestralky v XML nam poskytnete vhodné data pro experimenty, které provadime
v rdmci projektu CellStore - implemetnace XML-nativniho databazového stroje
http://cellstore.felk.cvut.cz

3z15 22.11.2010 10:43



X36DBS - Ctvrtek 7.30 - Zbyn&k Lstibiirek http://service.felk.cvut.cz/courses/X36DBS/xml/test/test.xml

Na tomto projektu se podili rovnéZ studenti (mimo jiné byl zdrojem nékolika velmi péknych
a jiz uspésné obhajenych bakalaiskych a diplomovych praci).

Zobrazeni semestralky v XML na WWW bylo tispé$né otestovéno na prohlize€ich FireFox 2 a
internet Explorer 7. Nefunguje napfiklad v prohlizeci Konquerror.

Mate-li néjaké (padné -) ) divody k tomu, Ze nemuZete semestréalku odevzdat formou XML,
feste to, prosim, individuainé se svymi cviéicimi.

datové schéma

Hias 1 _—"—__ + |pkRC: Variable string (10) pujcene_saty
clen SKUPINa | jmeng: Variable string (20)

pk zkratka: Variable string (&)

T 0.1 priimeni: Variabie string (20)
2ev_h! Intege

0.1 .
vedouci wvedena | adresa: Variable string (100)
\/ welefon: Varisble g GO) | T ———

email: Variable string G0)

0.1
pujceny_kus \\
¥ vytisk
drzitel L
pk cislo_exemplars: Integer
Skiadarel Publikace
Pk Jmeno: Variable string (30) Pk kat_cisla: Integer ®
pk prijmeni: Variable string (30) nazev_p: Variable string (100)
rok_narozeni: Integer variama: Variable string (30)
rok.umrti: Integer pocet_stran: Integer
dilo p_skladba
-
l_‘.
publikace zpivana_skladb
Cast_skladby Skladba
pl poradic Integer * |pkid: Integer
nazev_c: Variable string (255) autor | pazev: Variable string (100) | -

rok_vznku: Intager akee
durata: Integer

opus_C Imager

Datové schéma va$i semestralky by mélo byt zhruba takto rozsédhlé. Je Zadouci, abyste si pfi navrhu vyzkouseli
pokud moZno viechny konstrukty ER modelu:

silna entita

slaba entita (potaZzmo vztahové entita)

vztahy s riznymi kardinalitami (1-1, 1-N, M-N) a parcialitami (povinna, nepovinna dcast entity ve vztahu),
ISA hierarchie (pozor, tady je to vyrazné jiné, neZ jste zvykii z OOP)

Element imagedata, ktery reprezentuje obréazek, mé atribut fileref, kam musite napsat jméno obrazku.
Néktefi z vas ¢asem postoupi do magisterského studijniho programu a zapisi si pfedmét “Jazyk SQL".
Tam budete mit také vypracovat semestralni praci. V' zadani vam bude uloZeno, abyste navazali na vysledek této sem

|Nezapomerite si jeji dokumentaci peclivé uloZit. USelfite tim potom hodné préce. _
|l tento argument mluvi pro to, abyste své schéma navrhli dostatecné rozsahlé. | vyse zminéné smycky se vam budou |
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Moje schéma obsahuje smycku Zpévak — Prislusnost — Hlas — Vedeni — Zpévak. Toto je ovSem v pofadku,
protoze mezi entitami HLAS a ZPEVAK existuji dva nezavislé vziahy. Vztahy "je Clenem" a "je vedoucim”
nejsou vzajemné nijak oviviiovany. Vedoucim hlasové skupiny bude v drtivé v&tSiné pfipadd néktery z jeho
¢lend, ale mize jim byt i nékdo "zvenku”, kdo je ale také registrovan jako zpévak. Jiné feSeni kdy, bych napf.
zavedl atribut "je_vedouci" u vztahu Pfislusnost, by pokryvalo poZzadavek, Zze vedoucim skupiny typu HLAS
muize byt pouze pfislusnik skupiny, ale nebylo by mozné datove zajistit pravidlo, Ze skupina muze mit
jednoho vedouciho. MoZnym feSenim této problematiky by bylo i pfidani atributu "vedouci” k typu Hlas, ktery
by mohl nabyvat jakékoliv (i prazdné) hodnoty nepodléhajici Zadnému omezeni (Zadné kontrole).

Tohle je komentar k 1. odstavci diskuse dafového schématu.
Komentai mizZe mit vice fadkil.
Zachovdva formétovani.

ZPEVAK-UCAST-UDALOST-CAST_PROGRAMU_SKADBA-ZARAZENI-PUBLIKACE-VYTISK-
ZAPUJCKA_NOT. Interpretace této smycky z hlediska entity zpévak je takova, Ze zpévak mizZe mit pajéeny
noty na skladbu, ktera se nehraje na Zadné zkousce nebo koncerté, kterych by se zu€astnil. V "praktickem”
Zivoté je takova situace bézna (feknéme, Ze si noty oné skladby vyp(jéil z jiného divodu).

Dotazy

1. Seznam koncertl, na nichZ bylo vice nez 100 divaku

Komentér k popisu dotazu.
Koncert{div§ku >_100)
Komentar k relacni algebre.

SELECT *
FROM ‘Koncert
WHERE divaku > 100;

Komentar k SQL dotazu.

2. Seznam zpévakl, jejichZz vedoucim je Alena Havlikova.

A := {Hlas * Vedeni * Zpevak(jmeno='Alena' and prijmeni='Havlikova')}[zkratka]
Vysledek := Zpevak <hlas = zkratka] A

SELECT Zpevak.*

FROM Zpevak JOIN (
SELECT zkratka FROM Vedeni NATURAL JOIN Zpevak
WHERE jmeno='Alena' AND prijmeni="Havlikova'
) ON hlas=zkratka;

3. Stejné zadani jako predchozi, nyni s poddotazem v klauzuli WHERE.

SELECT ¥

FROM Zpevak

WHERE hlas = (
SELECT zkratka FROM Vedeni NATURAL JOIN Zpevak
WHERE jmeno='Alena' AND prijmeni='Havlikova'
)i

4. Nazvy vSech skladeb A. Dvofaka v repertoaru.

{Skladatel (jmeno="Antonin' and prijmeni='Dvofdk') *
ARutorstvi * Skladbal [nazev]

SELECT nazev
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FFROM Skladba NATURAL JOIN Autorstvi NATURAL JOIN Skladatel
WHERE jmeno='Antonin' AND prijmeni='Dvorak';

5. Seznam zpévak(, ktefi nemaji zapljceny Saty.

Zpevak \ {Zpevak <* Zapujcka satu}
SELECT * FROM Zpevak
MINUS
SELECT Zpevak.*
FROM Zpevak JOIN Zapujcka satu
ON Zpevak.RC = Zapujcka saltu.RC;

6. Stejné zadani jako pfredchozi, feSeni pomoci poddotazu.

SELECT *
FROM Zpevak
WHERE RC NOT IN (SELECT RC FROM Zapujcka satu);

7. Seznam dosud neprovedenych skladeb (nebyly na programu Zadného koncertu), véetné autorti.

B o= Skladba[id, néﬁévi-Y {Skladba <* {Cast programu * Kénceit}}[id, nazev)
Vysledek := {A * L Autorstvi}[jmeno, prijmeni, nazev]

ESELECT jmeno, prijmeni, nazev
|[FROM (
SELECT id, nazev FROM Skladba
MINUS
SELECT id, nazev FROM Skladba
NATURAL JOIN Cast programu NATURAL JOIN Koncert
) LEFT JOIN Autorstvi USING (id)
LEFT JOIN Skladatel USING(jmenc, prijmeni);

8. Seznam vicedilnych skladeb.

Skladba <* Cast skladby

ISELECT jmeno, prijmeni, nazev

|[FROM* (SELECT * FROM Skladba WHERE id IN (SELECT id FROM Cast_skladby)
JLEFT JOIN Autorstvi USING (id)
LEFT JOIN Skladatel USING(jmeno, prijmeni);

9. Program koncertu 18. 1. 2005.

{Skladba * Cast programu * Koncert(cas='18.01.2005")}[id, nazev]
ALTER Session SET NLS DATE FORMAT='DD.MM.YYYY';
SELECT jmeno, prijmeni, nazev
FROM Skladatel
JOIN Autorstvi using (jmeno, prijmeni)
JOIN Skladba using (id)
JOIN Cast programu using (id)
JOIN Koncert using (misto, cas)
WHERE TRUNC (cas)=TRUNC(TC DATE('18.01.2005'));

Schvainé si muZete vyzkousSet, Ze, kdyZ dotaz zménite takto:
SELECT jmeno, prijmeni, nazev -
FROM Skiadatel

NATURAL JOIN Autorstvi

NATURAL JOIN Skiadba

NATURAL JOIN Cast_programu

NATURAL JOIN Koncert
|WHERE TRUNC(cas)=TRUNC(TO_DATE('18.01.2005"));
Dostanete ve vysledku misto 7 fadka (spravna odpovéd) radka 3528.

Pro¢ je tomu tak?

Cela zdlezitost se pokazi projekci, pokud v klauzuli SELECT nechate *, je vysledek stale jesté spravny.
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10. Seznam zpévaki se 100% dochazkou.

Pokud bychom tedy trvali na pouZiti NATURAL JOIN, Ize dotaz formulovat takio:

Select jmeno, prijmeni, nazev
from
(select *
from skladatel
natural join autorstvi
natural join skladba
natural join cast_programu
natural join koncert
| WHERE TRUNC(cas)=TRUNC(TO_DATE('18.01.2005'))
)

Oracle ma zjevné v tomto kontextu problém, ale pouze tehdy, kdyZ pomoci NATURAL JOIN
spojujeme vice nez 3 tabulky. Napiiklad dotaz 7 funguje spravné.
At to budeme nazyvat "bug” nebo “feature”, je tfeba s timto fenoménem pocitati!!

ZpTavak <* (Ucast[RC] \ Ucast_{pritomen=0] [RC]}

SELECT Zpevak.*

'FROM Zpevak JOIN (

SELECT DISTINCT RC FROM Ucast

MINUS

SELECT DISTINCT RC FROM Ucast WHERE pritomen=0
} Vzorni ON Zpevak.RC=Vzorni.RC;

11. Stejny dotaz jako predchozi, tentokrat freSeny poddotazem. -

SELECT *

FROM Zpevak

WHERE RC NOT IN (
SELECT RC FROM Ucast WHERE pritomen=0
)i

12. Opét stejny dotaz feSeny vztaZenym poddotazem.

SELECT *

|FROM Zpevak

WHERE NOT EXISTS (
SELECT * FROM Ucast WHERE pritomen=0 AND Ucast.RC=Zpevak.RC
)i

13. Seznam zpévaki, ktefi nemaji noty na Ctyii pisné o Marii.

Zpevak \ {Zpevak <* [Zapujcka not * Publikace * Zarazeni
* Skladba(nazev='Ctyfi pisn& o Marii')}}
SELECT jmeno, prijmeni FROM Zpevak
MINUS
SELECT jmeno, prijmeni FROM Zpevak
JOIN Zapujcka not using (RC)
JOIN Publikace using (kat cislo)
JOIN Zarazeni using (kat_cislo)
JOIN Skladba using (id)
WHERE nazev='Cty¥i pisné o Marii';

Pro¢ ne NATURAL JOIN? Viz diskuse u dotazu 9.

14. Skladatelé, ktefi jsou autorem néjaké skladby a zarover upravovatelem néjaké skladby.

_gkladatel <*_Autc;:5tvi(j'_eruprava=_0}} N {Skladatel <* _Autorstvi_(je_uprava<§}_}

SELECT jmeno, prijmeni FROM Skladatel JOIN Autorstvi usin_g_(jmeno, prijmeni) WHERE je
INTERSECT
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15.

16.

17.

18.

19.

20.

8z15

|SELECT jmena, prijﬁéni

SELECT jmeno, prijmeni FROM Skladatel JOIN Autorstvi using (jmeno, prijmeni) WHERE je

Seznam publikaci, od kterych je v inventafi méné nez pét exemplari. Prvni realizaci mizeme
zjednodusit tak, vybereme ty publikace, kde existuji jen exemplaie s pofadovymi €isly < 5.

Publikace \ {PublIkace * V?iiék}[cislo_exemplare >=5itPubliE;ce.']

SELECT *
FROM Publikace A
WHERE NOT EXISTS (
SELECT * FROM Vytisk
WHERE A.kat_cislo=Vytisk.kat_cislo AND cislo_exemplare >= 3);

Stejny dotaz s pouZitim agregace, navic bez vySe pouzitého zjednoduseni.
SELECT * - I
FROM Publikace
WHERE 5 > (SELECT COUNT(*) FROM Vytisk
WHERE Publikace.kat cislo=Vytisk.kat cislo);

Seznam publikaci, které obsahuji vice neZ jednu skladbu.

Publikace <*
{Zarazeni[kat_cislo=k_c AND id < id d]Zarazeni<kat_cislo -> k ¢, id -> id d>}

SELECT *
FROM Publikace NATURAL JOIN (
SELECT DISTINCT A.kat cislo
FROM Zarazeni A JOIN Zarazeni B
ON A.kat _cislo=B.kat cislo AND A.id < B.id
)i

Stejny dotaz bl‘ehlednéji s agregaci.

~

SELECT *
FROM Publikace
WHERE 1 < (
SELECT COUNT (*) FROM Zarazeni
WHERE Zarazeni.kat cislo=Publikace.kat cislo

)i - -

Seznam zpévakl, ktefi nikdy nezpivali Zadnou skladbu Jana Hanuse,

-- V8echny udalosti, kde se zpivala néjaka skladba Jana Hanuge:
A := {Skladatel (jmeno='Jan' and prijmeni='Hanu3')
* Autorstvi * Skladba * Cast programu * Udalost}[misto, cas]
-- Seznam zpé&vaki, ktefi byli na nékteré z té&chto udalosti:
B := (A * Ucast(pritomen<>0) }[RC] |
Vysl := Zpevak \ {Zpevak * B}

FROM Zpevak
WHERE RC NOT IN (
SELECT RC FROM Ucast
WHERE (misto, cas) IN (
SELECT misto, cas
FROM Skladatel
JOIN Autorstvi using (jmeno, prijmeni)
JOIN Skladba using (id)
JOIN Cast programu using (id)
JOIN Udalost using (misto, cas)
WHERE jmeno='"Jan' AND prijmeni LIKE 'Hanus'
)
AND pritomen <> 0
):

Pro¢ ne NATURAL JOIN? Viz diskuse u dotazu 9.

Seznam vSech koncertl a generalek.
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{Koncert[cas, misto] X {('Koncert')}}
U {Zkouska(je_generalka) [cas, misto] x [ ('Generdlka')}}
SELECT cas, misto, 'Koncert' AS druh FROM Koncert
UNION
SELECT cas, misto, 'Generalka' AS druh FROM Zkouska WHERE je generalka<>0
ORDER BY cas;

21. Seznam koncertl, na nichZ byly provedeny vSechny skladby B. Martini na repertoaru.

—— ID vSech skladeb B. Martint:

SkladbyBM := (Skladatel (jmeno='Bohuslav' and prijmeni="'MartinQ')
* Autorstvi * Skladbal}{id]

-- VSechny kombinace koncert-skladba B. Martina:

VseKomb := SkladbyBM x Koncert[misto, cas]

-=- V3echny neuskutecnéné kombinace:

Nerealne := VseKomb \ Cast programu[id, misto, cas]

-- Koncerty, na nichZ chybé&la néjaka skladba B. Martini:

Neuplne := Koncert <* Nerealne

Vysl := Koncert \ Neuplne

SELECT misto, cas FROM Koncert
MINUS
SELECT misto, cas
FROM (SELECT id FROM Skladatel
JOIN Autorstvi using (jmeno, prijmeni)
JOIN Skladba using (id)
WHERE jmeno='Bohuslav' AND prijmeni="Martind'
) CRCSS JOIN Koncert
WHERE (id, _misto, cas) NOT IN (SELECT id, misto; cas
FROM Cast_programu) ;

22 Ktery zpévak ma nejvétsi z phjéenych Sata?
SELECT jmeno, prijmeni, wvelikost
FROM Zpevak

~"JOIN Zapujcka_satu using (RC)

JOIN Saty using (inv_cislo)
WHERE velikost=(SELECT MAX (velikost) FROM Saty NATURAL JOIN Zapujcka satu);

Pro¢ ne NATURAL JOIN? Viz diskuse u dotazu 9.

23. Prehled Gcasti na zkouskach (v procentech).

SELECT jmeno, prijmeni,
CAST ( (SELECT COUNT (*) FROM Ucast NATURAL JOIN Zkouska
WHERE Zpevak.RC=Ucast.RC AND pritomen<>0)
AS REAL)
/ (SELECT COUNT (*) FROM Ucast NATURAL JOIN Zkouska
WHERE Zpevak.RC=Ucast.RC
})*100 || * %' AS dochazka
FRCM Zpevak ORDER BY prijmeni;
24. Seznam hlasovych skupin: nazev, pocet ¢lend, jméno vedouciho.

SELECT nazev_h,
poc_clenu,
jmeno || * ' || prijmeni AS vedouci

FROM ({

SELECT zkratka, nazev_h, COUNT(RC) AS poc_clenu

FROM Hlas LEFT JOIN Zpevak ON Hlas.zkratka=Zpevak.hlas
GROUP BY zkratka, nazev_h

)
LEFT JOIN Vedeni USING(zkratka) LEFT JOIN Zpevak USING(RC); |

25. Seznam mist, na kterych se koncertovalo vicekrat a vZdy bylo pfitomno vice nez 50 divaka.
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|SELECT misto, count(misto) AS pocet koncertu, AVG(divaku) AS prum divaku
FROM Koncert

WHERE divaku > 50

GROUP BY misto

HAVING count (misto) > 1;

26. Skladatel nejvice zastoupeny na koncertech co do poctu skladeb.
--VyuZivam pohled rating skladatelu: _

SELECT jmeno, prijmeni, pocet

FROM Rating skladatelun

WHERE pocet = (SELECT MAX (pocet) FROM Rating skladatelu);

27. Pro divacky nejuspé&snéjsi koncert uréit rozdil ceny vstupného od priiméru.

SELECT (
SELECT vstupne FROM Koncert
WHERE divaku = (

SELECT max (divaku) FROM EKoncert
)

) =

SELECT AVG(vstupne) FROM Koncert

)

AS odchylka FROM Dual;

28. Skladatelé, ktefi se mohli b&hem Zivota setkat s Bohuslavem Marting.

SELECT * FROM skladatel
WHERE rok narozeni < (SELECT rok umrti FROM skladatel
WHERE jmeno='Bohuslav' AND prijmeni='Martinu')
AND rok umrti > (SELECT rok narozeni FROM skladatel
il WHERE jmeno='Bohuslav' AND prijmeni='Martina');

29. Seznam skladatell, jejichz skladby byly na programu koncert(i s nadpriimérnou navstévou.

SELECT DISTINCT jmeno, prijmeni
FROM skladatel
JOIN autorstvi using (jmeno, prijmeni)
JOIN skladba using (id)
JOIN cast programu using (id)
JOIN koncert using (misto, cas)
WHERE divaku > (SELECT AVG(divaku) FROM kconcert);

Pro¢ ne NATURAL JOIN? Viz diskuse u dotazu 9.

30. Koncert, na némz bylo uvedeno nejvice riznych skladeb.

SELECT *
FROM (
SELECT misto, cas, COUNT(*} AS pocet
FROM cast programu NATURAL JOIN koncert
CROUP BY misto, cas
} WHERE pocet = (
SELECT MAX (pocet) FROM (
SELECT COUNT (*) AS pocet :
FROM cast programu NATURAL JOIN koncert
GROUP BY misto, cas
)
):

31. Prehled oSaceni - v3ichni zpévaci a jejich Saty, zaroveri vSechny Saty a jejich drzitelé.
SELECT
COBLESCE (prijmeni, 'VOLNE') AS drzitel,
inv_cislo, velikost
FROM Zpevak LEFT JOIN Zapujcka satu USING(RC)
FULL JOIN Saty USING(inv_cislo);

32. Skladatelé a poget uvedeni jejich skladeb
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CREATE OR REPLACE VIEW rating skladatelu AS
SELECT jmeno, prijmeni, count(*) AS pocet
FROM Skladatel
JOIN Autorstvi using (jmeno, prijmeni)
JOIN Skladba using (id)
JOIN Cast_programu using (id)
JOIN Koncert using (misto, cas)
GROUP BY jmeno, prijmeni;

select * from rating skladatelu;

VSimnéte si syntaxe - CREATE OR REPLACE, co to déla je ziejmé - pokud pohled
Jiz existuje v datovém siovniku, je nahrazen novou definici.
Pokud by pohled existoval a vy zadali pouze CREATE VIEW, dostanete chybovou hiasku:
"ORA-00955: name is already used by an existing object”

Pro¢ JOIN USING namisto NATURAL JOIN? Viz poznédmka u dotazu 9.

33. Wtvofime redundantni tabulku ucasti_zpevaku, kde budou pfedspocitané hodnoty. Tuto tabulku
naplnime daty. Atribut koef vyjadiuje koeficient (ponechme stranou, co to znamena).

drop table ucasti zpevaku;

create table ucasti_ zpevaku (
rc number (10),
jmeno varchar2(30),
prijmeni varchar2(30),
zkousek number(4),
koncertu number(4),
koef number(1l)):;

insert into ucasti_zpevaku
SELECT re, jmeno, prijmeni,
-(SELECT COUNT (*) FROM Ucast NATURAL JOIN Zkouska
WHERE Zpevak.RC=Ucast.RC BND pritomen<>Q)
as zkousek,
| (SELECT COUNT(*) FROM Ucast NATURAL JOIN Koncert |
| WHERE Zpevak.RC=Ucast.RC AND pritomen<>0)
as koncertu,
0 as koef |
FROM Zpevak ORDER BY prijmeni; ;

commit;

select * from ucasti_zpevaku;

| Prikaz DROP TABLE na zaCétku této sekvence je zde opét proto, Ze piedpokiddame vicenasobné
|spousténi skriptu dotazy.sql (viz skripty). Pokud bude odvozena tabulka ucasti_zpevaku jiz

existovat, opét bychom dostali hidsku:

"ORA-00955: name is already used by an existing object”

Nicméné pfikaz CREATE TABLE nema variantu CREATE OR REPLACE!!!

U testovani DML prikazii (INSERT, UPDATE, DELETE) nezapomerite transakci ukonGit
pfikazem TCL (COMMIT - potvrzeni zmén nebo ROLLBACK - odvoldni zmén).

Kdyz to neudéléte, tak vam nésledné spusténi skriptu, prfipadné DML nebo DDL piikaz nad
stejnou tabulkou zdstane viset.

Z hlediska transakcniho zpracovani je to spravné feseni - zdroje v té tabulce jsou dosud
blokovany jinou transakcill!

Pokud se do této situace dostanete - miZe vam pomoci ukonceni SQL klienta, ze kterého
Jjste nepotvrzeny (tedy nendsledovany piikazem COMMIT ¢i ROLLBACK) DML prikaz posiali.
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Ale také to maZe systému chvili trvat nez se vzpamatuje, takZe je lepsi s tim poditat.

DDL priikazy (CREATE, ALTER, DROP) jsou "samo-potvrzovaci” - pfed jejich provedenim se
automaticky provede COMMIT a po jejich provedeni rovnéZ.

VySe uvedené 3 prikazy miZeme v SQL spojit do jednoho:

drop table_ucasti_zpevaku:

create table UCASTI_ZPEVAKU as
SELECT rc, jmeno, prijmeni,
(SELECT COUNT(*) FROM Ucast NATURAL JOIN Zkouska
WHERE Zpevak.RC=Ucast.RC AND pritomen<>0)
as zkousek,
(SELECT COUNT (*) FROM Ucast NATURAL JOIN Koncert
WHERE Zpevak.RC=Ucast.RC AND pritomen<>0)
| as koncertu,
0 as koef
FRCOM Zpevak ORDER BY prijmeni;

select * from ucasti_zpevaku;

34. Zpévakim, ktefi zpivaji alt nastavime v relaci ucasti_zpevaku hodnotu atributu koef tak, Ze vyjadiuje
pocet jimi zaptjcenych wytiskd not.

update ucasti zpevaku u
set koef =
(select count (*)
from zapujcka_not z
where u.rc = z.rc)
where u.rc in (select rc from zpevak where hlas = 'A');

commit;

35. Z tabulky ucasti_zpevaku vymazeme ty zpévaky, ktefi zpivaji basy.

delete from ﬁcasti_zpevaku
where rc in (select rc from zpevak where hlas = "B');

commit;

Tabulka pokryti kategorii SQL pfikazi

Kategorie Pokryta priklazy cislo: Charekteristika kategorie pfikazu
A 1,4,9 jednoduché dotazy (SELECT ... FROM ... WHERE)
B 1,3,8,9, 14, 15, 17, 20, 25, 28, 29 | VWber vSechny, pro néZ piati, ze...

C 5.7, 13 VWber viechny, pro néz NEplati, Ze...

D 10, 21 Vber ty, pro néZ viechny...

£ 19 Vyber ty, pro néz zadné. . )

F1 2,517 spojeni - JOIN ON -

F2 4,7,9, 13,19, 29, 31 spojeni - NATURAL JOIN | JOIN USING

F3 21 spojeni - CROSS JOIN

F4 7,8, 24,31 polospojeni (vn&jsi) - LEFT | RIGHT OUTER JOIN
F5 31 plné (wnéjsi) spojeni - FULL (OUTER) JOIN

G1 gé%g" 10 15:16,18.19,21, 2. ynoreny dotaz v iauzuli WHERE

G2 2,7,8,10,17, 21, 24, 30 vnofeny dotaz v klauzuli FROM
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G3 23,27 vnofeny dotaz v klauzuli SELECT

G4 12, 15, 16, 17 vztazeny vnofeny dotaz (EXISTS | NOT EXISTS)

H1 20 mnoZinové sjednoceni - UNION

H2 5,7, 10, 13, 21 mnozinovy rozdil - MINUS (v Oracle)

H3 14 mnozinovy prunik - INTERSECT

0 1518.22,23,24.25.26,21.29. | agreqatni funkee (count | sum | min | max| avg)

12 24, 25, 30| (aﬂAreVgl:énmi funkce nad seskupenymi fadky - GROUP BY

J 10+11+12 stejny dotaz ve tfech riiznych formulacich SQL

K 25 vSechny klauzule - SELECT FROM WHERE GROUP BY
HAVING ORDER BY

L 32 pohled VIEW

M 26 dotaz nad pohledem

L 33 INSERT .... SELECT pfikaz

M 34 UPDATE s vnofenym SELECT piikazem

N 35 DELETE s vnofenym SELECT prikazem

V semestréice se poZaduje alespori 10 dotazil v relaéni algebre a alespori 25 SQL piikazi.
SQL prikazi: samoZiejmé mizZete mit vice (jako v této semestréice), je ale podstatné, abyste
Jimi pokryli viechny kategorie ve vy3e uvedené tabuice.
Samoziejmé tedy jeden dotaz miZe pokryt vice kategoril.

Skripty -
Zdroj pro ER-modelar - pevecky sbor.xml

Skript pro vytvofeni databaze - create.sal - vytvofeny ER Modelafem, nicméné zde mizete udélat svoje
upravy. Samoziejmé je vhodné je komentovat.

1 v této sekci muZete komentovat jednotlivé odstavce.

KdyZ vyrobite uvnitf odstavce (para) entitu link, nezapomeiite,
Ze je treba u ni zadat téZ hodnotu atributu url.

Skript pro vioZeni dat do databaze - data.sqgl

Vase testovaci data by méla byt natolik rozsdhla a tak navrZend, abyste na nich mohli dobie ukazat,
Ze vami navrZzené SQL pfikazy funguji spravné.
Insert piikazy mdzZete psat pfimo v néjakém textovém editoru, ale mizete také své tabulky naplnit pomoci
formulais v nastroji SQL Developer, ktery umoZiuje exportovat data z tabuiek ve formé INSERT piikazi.

Skript s SQL dotazy, ktery je mozné pfimo spustit - dotazy.sql
Pokud méte k dispozici néjaky xslt procesor, pak si vy$e uvedeny skript miZete snadno vyrobit
ze zdrojového textu semestrélky pomoci forméatovaci $ablony
http://service.felk.cvut. cz/courses/X36DBS/xml/make sal queries script.xsl

IPoktm' nemate k dispozici XSLT procesor, ale pouZivate Firefox (nebo Mozillu - tedy Sea Monkey,
nebo jak se to viastné ted jmenuje), pak Ize pouZit tento postup:
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1. Stahnéte si html dokument:
htitp.//service.felk.cvut.cz/courses/X36DBS/xmi/zobraz_dotazy.html
a umistéte ho do svého projektového adresére na service.felk.cvut.cz.

2. Zdrojovy text vasi semestréalky (umistén tamtéz) necht’ se jmenuje semestralka.xml
(jinak je tieba naleiité editovat soubor zobraz_dotazy.html, viz komentare uvniti)

3. KdyZ nyni (ve FireFoxu nebo Mozille) nechéte zobrazit soubor zobraz_dotazy.htmi (umistény ve vasem
projektovém adresari), tak javascript vioZeny v této strance provede XSLT transformaci, jejimZ vysiedkem
bude strénka, ve které je vystupni skript dotazy.sql. Je uzavieny v elementu <pre> takZe zachovéava
forméatovani. Staci jej tedy pfes schranku vioZit do textového souboru dotazy.sql

Vysledek celého postupu aplikovany na ukazkovy soubor test.xml) je zde:
http://service.felk.cvut.cz/courses/X36DBS/xmiftest/zobraz_dotazy test. htmi

Jednotlivé SQL prikazy budete zfejmé ladit v nastroji SQLDeveloper, protoZe je to nejpohodingjsi.

Viele vSak doporucuji pouiit fadkového klienta sqlplus (pro generovani vystupu - viz dotazy.html) do vasi semestralky.
UmotZiiuje totiz formatovat vystup pfimo do html. Je to zafizeno pomoci prikazu |
SET MARKUP HTML a nékolika dal$ich piikazi SET, které nastavuji prostiedi SQL"Plus klienta:

set pagesize 1000

set echo on

set markup htmi on spool on head *

<title>X36DBS - Ctvrtek 7.30 - Zbynék Lstibdrek - Vystup SQL pfikazi <Aitle>

<style type ='text/css"><I-body {background: #ffffc6} —></style>"

body "<h2>X36DBS - Ctvrtek 7.30 - Zbynék Lstibirek - Vystup SQL pfikazii </h2>"
spool dotazy.htmi -~

...... pak jsou samotné dotazy, s jejich slovnim zadénim (komentar je uvozen pomoci —)

set markup html off
spool off

1! A jesté pozor - v tomto komentaii jsem kviii formatovéni rozdélil piikaz set markup thmi on

\na 4 radky. Nicméné v souboru dotazy.sql, tohle neprojde !!!!

Spusténi souboru dotazy.sql v prostfedi SQL*Plus klienta (na solarisech) vypada takto

(pfedpokladam, Ze v aktualnim adresafi méte skript dotazy.sql, po skonceni bude vystup v dotazy.htmi):
-bash-3.00% sqiplus

SQL"Plus: Release 10.2.0.2.0 - Production on Mon Sep 24 11:26:50 2007

Copyright (c) 1982, 2005, Oracle. All Rights Reserved.

Enter user-name: <vaze_uZivatelské_jméno>
Enter password: <vase_heslo>

Connected to: .

Oracle Database 10g Enterprise Edition Release 10.2.0.2.0 - Production
With the Partitioning and Data Mining options

SQL> @dotazy.sql
...... Ted se provadi dotazy, vystup jde na obrazovku a do souboru dotazy. htmi

SQL> quit

Disconnected from Oracle Database 10g Enterprise Edition Release 10.2.0.2.0 - Production

With the Partitioning and Data Mining options
-bash-3.008
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(Jak vidno, podstatnym pfikazem v SQL*Plus kiientovi je "@jmeno

Vystup predchoziho skriptu - dotazy html.

Vyrobil jsem ho vySe uvedenym postupem - tedy s pouZitim Sablony. kiera ze zdrojového textu vasi semestrélky
vytdhne pouze SQL piikazy (a jejich slovni specifikaci, ze které udéla komentar) a obalf to fidicimi prikazy
pro vytvoreni HTML stranky.
Viychazim z toho, Ze piikazy budete ladit jednotlivé (zfejmé v nastroji SQL Developer, kde to je velmi pohoding).
Pro celkovou kontrolu je vSak mnohem lepsi mit vSechno pékné v jednom dokumentu.

Zaveéer

Uspésné jsem vytvoril sviij prvni databazovy projekt a osvojil jsem si zakladni metody databazového navrhu.
Vzniklé databazi Ize jisté vytknout fadu nedostatkd. Ty prameni zejména z toho, Zze v dobé vytvareni ER
schéematu jsem nemél jasnou pfedstavu o nékterych implementaénich problémech souvisejicich napf. se
spojovanim tabulek. Kdybych navrhoval databazi znowu, asi bych nevolil za kli¢ Fetézcové atributy, tim méné
jejich dvojice. Také bych Iépe rozloZil atributy v ISA hierarchii Udalost-Koncert-Zkougka, aby se napf. misto
konani nekopirovalo do vSech instanci (to souvisi i s pfedchozi poznamkou o volbé klith). Protoze jsem si tyto
problémy zacal naplno uvédomovat teprve v okamziku, kdy jsem mél jiZ hotova zkuSebni data a zabyval se
dotazy, rozhodl jsem se schéma jizZ neménit a vyhnout se tak zavleCeni néjakych dalsich chyb.

Stejné tak ize komentovat zavér.

Odkazy
[1] Pokomny, Jaroslav, Halaska, Ivan, Databazoveé systémy, Praﬁa 1998

A bude-li to tfeba, mizZete komentovat také odkazy.

[2] SimGnek, Milan, SQL, kompletni kapesni priivodce, Praha 1997
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